appliedbiosystems

Cystic Fibrosis Transmembrane Conductance

Regulator (CFTR) Genotyping Experiments
APPLICATION GUIDE

for use with:
OpenArray" Genotyping Plates

QuantStudio™ 12K Flex instrument with OpenArray™ block (AccuFill™
System)

TagMan" Genotyper Software

Publication Number MANOQ014405

Revision A.Q

ThermoFisher

For Research Use Only. Not for use in diagnostic procedures. SCIENTIFIC



The information in this guide is subject to change without notice.
DISCLAIMER

TO THE EXTENT ALLOWED BY LAW, LIFE TECHNOLOGIES AND/OR ITS AFFILIATE(S) WILL NOT BE LIABLE FOR SPECIAL, INCIDENTAL, INDIRECT,
PUNITIVE, MULTIPLE, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM THIS DOCUMENT, INCLUDING YOUR USE OF IT.

Important Licensing Information

These products may be covered by one or more Limited Use Label Licenses. By use of these products, you accept the terms and conditions of all
applicable Limited Use Label Licenses.

Revision history

Table 1 Revision history of Pub. no. MANOO14405

Revision Date Description

A.0 25 February 2016 New document

Corporate entity
Life Technologies Corporation | Carlsbad, CA 92008 USA | Toll Free in USA 1 800 955 6288
TRADEMARKS

All trademarks are the property of Thermo Fisher Scientific and its subsidiaries unless otherwise specified.

©2016 Thermo Fisher Scientific Inc. All rights reserved.



Contents

B CHAPTER1 Introduction and workflow overview ..........c.ccvv..... 6
Qualified TaqManTM SNP Genotyping Assays for CFTR mutations ....................... 6
Workflow: OpenArraym plate CFTR experiments ........ ..ottt 7

B CHAPTER 2 Background and tools for assay content selection ...... 8
Taq Man" SNP GENOtYPING ASSAYS . .ottt ittt et 8

CFTR nomenclature ... ... .. ..o e ettt enns 9
Assay context SEQUENCES . .. ..ottt e e 9
Plate products and formats for CFTRassays .........coiiiiiiiiiii it ii i enennn 9
TaqManTM OpenArrayTM Genotyping plate products and formats .................... 9
TaqManm SNP Genotyping Assay single-tube products and formats .............. 10
Optional CFTR controls . ... ..o oo i et e e 10
Tools for finding qualified TaqManm CFTR mutationassays .........ccoviiiiiiennnnnns 10
Search for TaqManTM CFTR ASSAYS - vttt ettt et 11
CFTR TaqManm SNP Genotyping Assays Index ..........ccoviiiiiiiniinnnnenn.. 12
Non-standard CFTR TaqManTM SNP genotypingassays ..........cciiviiiiiieninannnn. 13
CFTR TaqManm SNP genotyping assays to triallelicSNPs ....................... 13
CFTR TaqManm SNP genotyping assays to regions with multiple mutations ....... 14
CFTR TaqManTM SNP genotyping assays to the 5T/7T/9T polymorphism ........... 14
CFTR TaqManTM SNP genotyping assays to large CFTR mutations ................. 15
0] oo 1= ol T =T ) 16
Order custom OpenArraym plates ... e 16
Order single tube TaqManm ASSAYS + ittt 17

M CHAPTER3 Isolate DNA using the MagMAX DNA Multi-

Sample Ultra Kit ... e e 18
Kit contents and storage ......... ..ot e 18
Required materials not supplied ........ .. i e 19
Download the KingFisherm FleX program ...ttt it et e et e e e 21
Setupthesamplelayout ........ ... i e 22

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR] Genotyping Experiments User Guide 3



Contents

Isolate DNA from buccal swabs . ... ... . i e 22
Guidelines for buccal swab preparation ........... ... . . i i 22
Before first use of the kit: prepare Wash Solutions ............................. 23
Before each use of the kit: prepare DNA BindingBead Mix ...................... 23
Digest the samples with Proteinase K ......... ... . it 23
Setupthe processingplates ...t i i i it e 24
Add Multi-Sample DNA Lysis Buffer, isopropanol, and DNA Binding Bead Mix ....... 25
Process samples ontheinstrument ........ ... . ... .. i 25

Isolate DNA from blood leukocytes ... i i e i e 26
Guidelines for blood leukocyte preparation ............ ... .o 26
Before firstuseof the kit ...... ... i 27
Before each use of the kit ...... .. .. i 27
Lyse the red blood cells and pellet the leukocytes . ......... ... s, 27
Digest the samples with Proteinase K .......... .. it 28
Set up the processing plates ....... ...t e e 29
Add Multi-Sample DNA Lysis Buffer, Bead/RNase A Mix, and isopropanol ......... 29
Process samples ontheinstrument ........ ... .. . i i e 30

DNA concentration and quantification .......... ... . ... 31

B CHAPTER4 Prepare and run OpenArray CFTR SNP

genotyping eXperiments .......ocieiiiiii i i, 32
WoOrK oW .o e 33
Required materials: OpenArraym plateworkflow ........ .. ... i 33
Generate 384-well sample plate layouts in OpenArrayTM Sample Tracker Software ...... 34
Set up the PCR reactions in the 384-well plate for Accu Fill" system transfer .......... 35
Set up the Accu Fill" INSEFUMENT oottt e e e e e e e 36
Transfer reactions to the OpenArrayTM plate in the AccuFill” instrument ............... 37
Seal the OpenArrayTM Plate .. e et e e e 38
Run the OpenArray  plate(s) on the QuantStudio 12K Flex instrument ............... 39
Check the QC IMages . ...t e e e 40
To recover from layout errors in the 384-well sampleplate ............ ... ... ...l 40
One-time ProcedUrES . ... ittt e e 41
Set up default folders and software preferences ............ ..o, 41
Download SPF files . ... i e e, 42

B CHAPTERS5 Analyze CFTR genotypingdata .......................... 43
Analysis options for CFTR genotypingdata ......... ... .. .. i 43
Analyze results in TaqManm Genotyper Software ...t i e 44
One-time ProCeduUres . . ... ittt et et 45
Analyze data in QuantStudio 12K Flex or Thermo Fisher Cloud Cloud software . ....... 46
Analysis guidelines: SNP genotyping assays to triallelicSNPs ....................... 47
Analysis guidelines: SNP genotyping assays to regions with multiple mutations ........ 49

4 Cystic Fibrosis Transmembrane Conductance Regulator [CFTR] Genotyping Experiments User Guide



Contents

Analysis guidelines: SNP genotyping assays to the 5T/7T/9T polymorphism ........... 53
Analysis guidelines: SNP genotyping assays to large CFTR mutations ................. 54
B CHAPTER 6 Confirm positiveresults ..........cociiiiiiiiiiiiiinnn. 56
Guidelines for confirmation of positiveresults ....... ... ... .. .. i it 56
Review real-time trace data to confirm positiveresults .............. ... ... ... ..... 57
Real-time trace dataexamples ...t it i et et e i 58
Prepare and run single-tube experiments .......... ... i 60
Workflow: single-tube CFTR experiments .......... ..ottt 60
Required materials: single-tube workflow ........ ... .. .. .. . L, 60
Prepare the DNA sample plate:wet DNA . ... ... i 61
Prepare the DNA sample plate: dry DNA . ... ... i i e 61
Perform PCR (single-tubeassays) ...t 62

APPENDIX A RNase P Quantification for

genotyping eXperiments .......cocuiiiiiiiiii i, 63
Required materials ...ttt i i e ittt ettt it e 63
Before you begin ... ... 64
Set up and run the PCR, then quantifythe DNA . ... .. ... ... .. . ... 64
APPENDIX B Safety ....oovniiii e 66
Chemical safely ... .o i et e e et e et e 67
Biological hazard safety .........c.cciiiiiii i e it 68
Documentation and support ........oviiiiiiiiiiiiii i 69
Related documentation .. ... ... .. i e 69
Customer and technical support . ........ i i e 69
Limited product warranty ...... ... i i i i e it et e 70
N X e e 71

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR] Genotyping Experiments User Guide 5



\ |
=0
"‘
WAV/
5%

AN
AV
WA

Introduction and workflow overview

s

L)
D,

,

B Qualified TagMan™ SNP Genotyping Assays for CFTR mutations ........... 6
®  Workflow: OpenArray'" plate CFTR experiments ......................... 7

A CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard
types specified in procedures may be abbreviated in this document. For the
complete safety information, see the “Safety” appendix in this document.

IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

This guide describes the OpenArray™ plate high-throughput, sample-to-result
workflow for genotyping CFTR mutations in buccal and leukocyte samples. The
workflow uses:

e TagMan"™ SNP Genotyping Assays in OpenArray " plates
¢ QuantStudio™ 12K Flex instrument with OpenArray™ block (AccuFill™ System)

e (Optional) Thermo Fisher Cloud GT Analysis module at www.thermofisher.com/
us/en/home/cloud.html

e TagMan™ Genotyper Software

Qualified TagMan™ SNP Genotyping Assays for CFTR mutations

™

We offer a collection of ~200 qualified TagMan™ SNP Genotyping Assays that have
been optimized for genotyping key CFTR mutations. Target coding and regulatory
mutations were selected from the Cystic Fibrosis Mutation Database (CFTR1)
Database ( www.genet.sickkids.on.ca) and the Clinical and Functional Translation of
CFTR (CFTR2) Database (www.cftr2.org). Additional TagMan™ SNP Genotyping
Assays for CFTR mutations are available from our extensive predesigned SNP assay

™

collection or can be ordered through our custom TagMan™ SNP assay design service.

Qualified CFTR mutation assays demonstrate accurate, reproducible performance in
multiple rounds of testing and perform well with DNAs isolated from blood
leukocytes and buccal cell samples isolated using optimized MagMAX™ DNA Multi-
Sample Ultra Kit protocols (see “Isolate DNA from buccal swabs” on page 22 and
“Isolate DNA from blood leukocytes” on page 26).
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Chapter 1 Introduction and workflow overview EZ82
Workflow: OpenArray™ plate CFTR experiments |

The diverse nature and the rarity of key CFTR mutations presented challenges in

developing TagMan™ assays. We designed the assays using the proprietary Applied
Biosystems™ TagMan™ SNP Genotyping Assays design pipeline:

* Nontarget SNP positions in mutation context sequences were stringently masked
to avoid designing assays over known SNPs that could interfere with assay
performance.

e The target uniqueness of assay designs was checked by alignment to genomic
sequences.

* All assay designs were qualified to meet stringent specificity and sensitivity
criteria:

— Assays were initially run in real-time PCR on both 384-well plates and
OpenArray ™ plates with 47 Coriell gDNA samples that include 44 total
characterized CFTR mutations (www.coriell.org) .

— Because most CFTR mutations are rare and control gDNAs are not available
for all targets, assays were also tested with synthetic DNA controls
representing three genotypes for each CFTR variant, to ensure robust
discrimination of alleles and genotypes .

Workflow: OpenArray  plate CFTR experiments

Chapter 3, “Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit"
v

Chapter 4, “Prepare and run OpenArray” CFTR SNP genotyping
experiments”

v

Chapter 5, “Analyze CFTR genotyping data”

Review assay guidelines for non-standard assays.

IMPORTANT! If you are interrogating mutations that require two assays,
review the data for both assays together.

v

Chapter 6, “Confirm positive results”

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide 7
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TagMan™ SNP Genotyping Assays

TagMan™ SNP Genotyping Assays contain sequence-specific forward and reverse

primers to amplify the genomic region of interest and two TagMan™ MGB probes
with Non-fluorescent quencher (NFQ):

* One probe labeled with VIC™ dye detects the Allele 1 sequence.
* One probe labeled with FAM™ dye detects the Allele 2 sequence.

Data is analyzed by cluster plot analysis: FAM™ dye signal is plotted on the Y-axis and
VIC™ dye signal is plotted on the X-axis. Samples homozygous for the FAM™ or VIC™
dye-labeled alleles form clusters along the Y- or X-axis. Heterozygous samples contain

both FAM™ and VIC™ dye signals and are grouped in clusters roughly along the
diagonal position between the homozygous clusters.
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CFTR
nomenclature

Assay context
sequences

[

Chapter 2 Background and tools for assay content selection B
Plate products and formats for CFTR assays [ &5

35

28)

CFTR researchers often use descriptive legacy nomenclature to identify mutation
targets. Many legacy names are imprecise; for example, amino acid change names are
often used instead of the specific nucleotide change.

In an effort to standardize CFTR mutation names, the Cystic Fibrosis Mutation
Database (CFTR1 database www.genet.sickkids.on.ca) converted legacy CFTR
nomenclature to Human Genome Variation Society (HGVS) nomenclature, which uses
standardized rules for naming variants mapped to reference genome, transcript, and
protein sequences. The new CFTR nucleotide and protein names and the associated
legacy names are provided on the CFTR1 database website

( www.genet.sickkids.on.ca), and a subset of these are also listed on the Clinical and
Functional Translation of CFTR website (CFTR2 database www.cftr2.org).

The context sequence is the nucleotide sequence surrounding the SNP site. It is

provided in the (+) genome strand orientation relative to the NCBI reference genome.
The SNP alleles are included in brackets, where the order of the alleles corresponds to
the association with probe reporter dyes: [Allele 1= VIC™ dye / Allele 2 =FAM™ dyel].

The reporter dye information is represented in the assay context sequence, which is
posted on thermofisher.com. It is also provided in the Assay Information File:

e OpenArray " plates - Download from www.thermofisher.com/OA-platefiles
e TagMan™ Array 384-well plates — Provided with your order

* Single-tube - Download from www.thermofisher.com/tagmanfiles

Note that for many, but not all, of the qualified CFTR mutation assays, the wild type
allele is identified by the VIC™ dye-labeled probe and the mutant allele by the FAM™
dye-labeled probe.

For example, in Assay ID: C_151693869_10, which targets F508del, c.1521_1523delCTT
(SNP ID: rs113993960), has the following context sequence: The VIC™ dye-labeled

probe is associated with the deletion allele and the FAM™ dye-labeled probe is
associated with the wild type allele.

5'-CTGGCACCATTAAAGAAAATATCAT [-/CTT] TGGTGTTTCCTATGA
TGAATATAGA-3'

Plate products and formats for CFTR assays

TagMan™
OpenArray”
Genotyping plate
products and
formats

OpenArray  plates contain pre-plated, dried down TagMan = SNP Genotyping
Assays.

Number of Number of
Array format 1 Cat. no.
assays samples
32 26 96 4671114 (447017112))
b4 60 48 4471115 (4470172[2))
128 120 24 4471116 (447017312))
192 180 16 4471117 (447017412

[ Number of assays recommended for optimal performance in this format.
[ Cat. no. if ordered through a sales representative

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide 9
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= Optional CFTR controls

Taq Man" SNP TaqManTM single-tube assays can be used to confirm positive results.

Genotyping Assay

. Number of reactions .

smgle-tu be Product Assay mix Cat. no. (Human)

products and Scale 384-well 96-well formulation

formats Small 1500 300 40x 4351379
Medium 5000 1000 40x 4351376

Large 12000 2400 80x 4351374

Optional CFTR controls

The CFTR TagMan'" Assay Controls (Cat. no. A30421) can optionally be used in
CFTR experiments to verify results and to assist with troubleshooting.

For information on the controls kit, refer to CFTR TagMan" Assay Controls Quick
Reference (Pub. no. MAN0014633).

Tools for finding qualified TagMan" CFTR mutation assays

* Assay search tool available at www.thermofisher.com/ordertagman

™

* CFTR TagMan™ SNP Genotyping Assays Index available at
www.thermofisher.com/cftr

10 Cystic Fibrosis Transmembrane Conductance Regulator [CFTR] Genotyping Experiments User Guide
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Tools for finding qualified TagMan™ CFTR mutation assays | e
Search for 1. Go to www.thermofisher.com/ordertagman.
™
TagMan CFTR _ .
assays Assay Search Tool - Find & Buy Your Single Tube TagMan® Assays:
What type of experiment are you conducting?
\\(} Gene Expression kE/ SNP Genotyping { = Copy Number é‘? siRNA
i e
Q MicroRNA ?/ Mutation Detection \1 r’ Antibodies
What type of assay do you want?
All SNP Genotyping Drug Metabolism Assays
What species do you want to target? (Select one or more)
[Hs] Human [Mm] Mouse All
*  Enter target information
e.g., Assay |D, dbSNP ID, Gene Symbol, hCV ID
@ Enter / Upload Multiple Targets
Include 10kb Flanking Region
What chromosome position are you interested in?
MNurmber Position/Start Position/Stop
Search
2. Select SNP Genotyping » All SNP Genotyping » [Hs] Human.
3. Under target information, enter CFTR, then click Search to search for the
complete mutation assay set.
Optionally, specify other search terms (including rsSNP ID and assay ID) or
specify chromosome position. You can use the Enter/Upload Multiple Targets
option to specify multiple search terms.
4. Under Narrow Your Results (to the left of the results), select CFTR Gene and
Qualified Assay Type.
Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide 11
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£ Tools for finding qualified TagMan™ CFTR mutation assays
5. Review the information for each assay: click View Assay on Map, View Details,
and View Allele Frequency (if available).
Note the following:
* Read any Important Information notes associated with the assay (click the
Important Information box next to an Assay ID). Notes provide information
required to make ordering decisions and analyze data. For example, two
assays may be required to interrogate one target mutation (for example,
triallelic SNPs or CFTRdele2,3).
¢ The annotation for triallelic SNP assays and large deletion assays is tied to
the SNP ID and not to specific alleles. Review the Important Information or
the assay context sequence to determine the target alleles of each assay.
¢ View Details provides allele nomenclature (mutation names: legacy,
nucleotide, and protein), which links to the CFTR1 database website
6. If you need a list of assays for ordering, select the assays of interest, then click
Export (at the top of the page).
The exported results contain the assay ID and annotations (catalog number, SNP,
gene, context sequence, genomic location, and allele nomenclature).
CFTR TagMa n" Download from www.thermofisher.com/cftr.
SNP Genotyping This file contains a comprehensive list of the qualified TagMan™ CFTR mutation
Assays Index assays with the following annotations:
e Assay ID
* Gene symbol
¢ Mutation common name
* Mutation cDNA name
* Mutation protein name
* Mutation legacy name
e SNPID
¢ NCBI cds annotation
¢ NCBI protein annotation
¢ NCBI assembly build
e NCBI assembly location
¢ Context sequence
12 Cystic Fibrosis Transmembrane Conductance Regulator [CFTR] Genotyping Experiments User Guide
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Non-standard CFTR TagMan™ SNP genotyping assays

Non-standard CFTR TagMan™ SNP genotyping assays

CFTR TagMan™
SNP genotyping
assays to triallelic

SNPs

CFTR triallelic SNPs have three bases that occur at the same genomic location.
Triallelic SNP alleles are interrogated using two TagMan " assays. Each assay contains
a probe for the wild type allele and a probe for one of the mutant alleles.

To generate accurate sample genotypes, run the two assays independently on the
same samples, then analyze the allelic discrimination results together and compare
the expected cluster positions from both assays. For information, see “Analysis
guidelines: SNP genotyping assays to triallelic SNPs” on page 47.

Table 2 TagMan™ CFTR assays to triallelic SNPs

Assay alleles

SNPID Assay IDI"] Mutation Mutatit_m HGVS Mutati.on HGVS labeﬂlded wiw
legacy name nucleotide name protein name VIC ' /FAM

dye

rs121908751 C_32545261C_10 E92K c.274G>A p.Glu92Lys G/A

rs121908751 | C_32545261D_2012 E92X c.274G>T p.Glu92Ter G/T

rs121908761 C_26083714C_10M2 Y1092X(C->A) c.3276C>A p-Tyr1092X C/A

rs121908761 C_26083714D_20 Y1092X(C->G) c.3276C>G6 p.Tyr1092X C/G

rs121908799 | C172767555C_30 2183AA->G | c.2051_2052delAAinsG | p.Lysé84SerfsX AA/G
38

rs121908799 | C172767555D_20 2183delAA €.2051_2052delAA | p.Lys684ThrfsX AA/-
4

rs121908805 | C_64676233C_10 S466X(TAA) c.1397C>A p.Serb66X C/A

rs121908805 C_64676233D_20 S466X(TAG) c.1397C>G p.Ser466X C/G

rs77932196 C__ 656878C_302 R347P c.1040G>C p-Arg347Pro C/G

rs77932196 C__ 656878D_20 R347H c.1040G>A p.Arg347His A/G

rs80055610 C_27861436C_30 R560T c.1679G>C p.Arg560Thr G/C

rs80055610 C_27861436D_2012 R560K .1679G>A p.Arg560Lys G/A

1" Assay IDs for an assay pair contain the same core number with a C or D.

(21 This assay has nonspecific activity for the nontarget allele. You must run and analyze both triallelic SNP assays to ensure accurate results.

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide

13



9% Chapter 2 Background and tools for assay content selection

Non-standard CFTR TagMan™ SNP genotyping assays

CFTR TagMan™
SNP genotyping
assays to regions
with multiple
mutations

Some qualified CFTR mutation assays cover probe-binding sites that contain one or
more mutations that are close to the target mutation. These nearby nontarget
mutations do not typically interfere with genotype analysis of the target mutation in
heterozygous samples because these rare mutations are not found together in cis on
the same chromosome.

Table 3 TagMan" SNP Genotyping Assays to the CFTR F508del region mutations

Assay alleles
SNPID Assay ID Mutation Mutation HGVS Mutation HGVS | labeled with
y Legacy name nucleotide name protein name VIC"/FAM™
dye
rs1800091 C__59055679_20 1506V c.1516A>G p.lleb06Val A/G
rs121908745 C_151693868_10 1507del c.1519_1521delATC p.lle507del ATC/-
rs1801178 C__ 8853252 20 1507V c.1519A>G p.lle507Val A/G
rs113993960 C_151693869_10 F508del €.1521_1523delCTT p.Phe508del -/CTT
rs74571530 C_100964862_10 F508C c.1523T>G p.Phe508Cys G/T
Table 4 TagMan" SNP Genotyping Assays to the CFTR 2184delA region mutations
Assay alleles
SNP ID Assav ID Mutation Mutation HGVS Mutation HGVS | labeled with
y Legacy name nucleotide name protein name VIC"/FAM™
dye
rs121908799 C172767555D_20 2183delAA €.2051_2052delAA p.Lys684ThrfsX AA/-
4
rs121908799 C172767555C_30 2183AA->G €.2051_2052delAAinsG | p.Lysé84SerfsX AA/G
38
rs121908786 C_172767550_10M" 2184insA ¢.2052_2053insA p.Glné85ThrfsX -/A
4
rs121908746 C_172767547_20 2184delA c.2052delA p.Lys684Asnfs A/-
X38

1 Assay C_172767550_10 to the rare 2184insA homopolymer mutation is not recommended in the OpenArray™ plate format . This assay
distinguishes 7 from 8 A bases. The separation between heterozygous and wild type clusters in allelic discrimination plots is very low. Review
real-time PCR trace data to confirm suspected heterozygous results.

CFTR TagMan™
SNP genotyping

assays to the
5T/7T/9T

polymorphism

14

The CFTR 5T/7T/9T polymorphism, or triallelic polyT variant, is a component of the
intron 8 polyAG/polyT mutation. The 5T mutation affects CFTR RNA splicing,

resulting in low levels of CFTR protein. The 5T mutation is incompletely penetrant.

Two assays are required to genotype the polyT mutation:

for the 5T mutant allele (FAM " dye).

e The 9T assay contains a probe for the wild type 7T allele (FAM " dye) and a probe
for the 9T variant allele (VIC ™ dye).

e The 5T assay contains a probe for the wild type 7T allele (VIC " dye) and a probe

Cystic Fibrosis Transmembrane Conductance Regulator [CFTR] Genotyping Experiments User Guide
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Non-standard CFTR TagMan™ SNP genotyping assays

<K

To generate accurate sample genotypes, run the two assays independently on the
same samples, then analyze the allelic discrimination results together and compare
the expected cluster positions from both assays. For information, see “Analysis
guidelines: SNP genotyping assays to the 5T/7T/9T polymorphism” on page 53.

Table 5 TagMan" SNP Genotyping Assays to the CFTR 5T/7T/9T (polyT) mutation

SNP ID

Assay

Mutation |\, i-tion HGVS Mutation HGVS e

Legacy nucleotide name rotein name L
name P VIC"/FAM™

dye

Assay ID

rs387906372

C203006801C_10 5T

¢.1210-12T[5_9] No protein name TT/- (7T/5T)

rs387906372

C203006801D_20 9T

¢.1210-12T[5_9] No protein name TT/- (9T/7T)

CFTR TagMan™
SNP genotyping
assays to large
CFTR mutations

CFTRdele2,3 and CFTRdele22,23 are large deletion mutations that are each
interrogated by a pair of modified TagMan " copy number assays. Each assay contains
one functional probe:

* Wild type allele assay — One functional probe (VIC" dye) and one non-functional
probe (FAM" dye)

e Mutant allele assay — One functional probe (FAM " dye) and one non-functional
probe (VIC" dye)

The non-functional probe allows these copy number assays to be run with SNP assay
sets.

To generate accurate sample genotypes, run the two assays independently on the
same samples, then analyze the allelic discrimination results together and compare
the expected cluster positions from both assays. For information, see “Analysis
guidelines: SNP genotyping assays to large CFTR mutations” on page 54.

Table 6 TagMan™ SNP Genotyping Assays to large deletion mutations

Assay IDI"]

Assay alleles

Mutation HGVS labeled with

Mutation legacy | Mutation HGVS nucleotide

name name protein name VIC™/FAM™ dye
C990000002A_10 CFTRdele2,3 | c.54-5940_273+10250del21kb | p.Ser18ArgfsX16 -/mu
C990000002B_20 CFTRdele2,3 c.54-5940_273+10250del21kb | p.Ser18ArgfsX16 wt/-
C990000003A_10 CFTRdele22,23 | c.3964-78 4242+577del1.5kb No protein name -/mu
C990000003B_20 CFTRdele22,23 | ¢c.3964-78_4242+577del1.5kb No protein name wt/-

1 Assay IDs for an assay pair contain the same core number with A or B.

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide 15
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Order assays

Order assays

Order custom 1. Go to www.thermofisher.com/order/custom-array/.
OpenArray” plates

Custem Array = Format

Welcome to the TagMan® Array Configurator
Complete your custom array order in 3 steps.
1. Select an array type and format below.
2. Populate your array using our import or search tools, then make your customizations.

3. Complete your design and submit a request.

Select your array type:

Array Type QOptions: |E|

Select your array format:

After selecting an Array Type abave, this space will populate with available formats.

2. For array type, select TagMan™ OpenArray " Genotyping Plates.
3. Click View Layout to display the assay format in a plate.

4. Click Select to configure a plate.

Customn Array Configurator

Q Search For Assays Q Find Custom Assays & Import Your Assay List Complete Your Design >

o Enable Replacement Assays?
Replacements assays ensure you get the most from your OpenArray plate. Please choose from the following 3 options:

NoThanks | Enabled - Specify How | Enabled - Specify Later | Help

Array name" Array 1D Array type Format Unique Targets Filled  hvalid ~ Empty
Tathan® Openaray® Genotyping Plates wo 0 o - |
Select Edit Move Export Help Save Your Array
Click to select assays | Click & drag to move assays | Cirl+C to copy an assay | Cirl+V to paste an assay
1 2 El 4 § & 7 8
Display Assay Target E'
~ i Sub Array Al
b Filled 0
. Invalid 0
Empty

[
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Chapter 2 Background and tools for assay content selection
Order assays

5. Click Import Your Assay List, then select a tab-delimited text file (.txt) containing
Assay IDs or paste the IDs in the Enter a list of Assays IDs field, then click
Import Entered List.

6. When the plate is configured, click Complete Your Design, then follow the
screen instructions to complete the order.

Order single tube You can order single-tube assays in two ways:

Taq Man™ assays e “Search for TagMan™ CFTR assays” on page 11, add assays to the shopping cart,
then complete the order.

¢ If you have already obtained catalog numbers and IDs (Assay IDs), click Quick
Order at the top of any page at thermofisher.com.

| Qick Order m‘
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Kit contents and storage

18

Cat. no. A25597!"1 | Cat. no. A25598!2!

Component Storage
(500 rxns) (2500 rxns)

Proteinase K& 4mL 5x 4 mL -25°C to -15°C
PK Buffer 96 mL 5% 96 mL

. . 15°C to 30°C
Multi-Sample DNA Lysis 100 mL 5 x 100 mL
Buffer
RNase A4 2x1.25mL 10 x 1.25 mL -25°C to -15°C
DNA Binding Beads!® 8 mL 5x8mL 2°C to 8°C
Nuclease-free Water 100 mL 5x 100 mL
Wash Solution 1 5] 5]
Concentrate 80mL 5x80mL 15°C to 30°C
Wash Solution 2 162 mL! 5 x 162 mL]

Concentrate
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Cat. no. A25597!" | Cat. no. A25598!2!
Component Storage
(500 rxns) (2500 rxns)
DNA Elution Buffer 1 25 mL 5x 25 mL
15°C to 30°C
DNA Elution Buffer 2 25 mL 5x25mL

1 Also available as Cat. no. A25919, containing Cat. no. A25597 with one additional tube each of Proteinase K
(4 mL) and DNA Binding Beads (8 mL).

Also available as Cat. no. A25920, containing Cat. no. A25598 with 5 additional tubes of Proteinase K (4 mL
each) and 5 additional tubes of DNA Binding Beads (8 mL each).

Bl Proteinase K is also available as Cat. no. A25561 and DNA Binding Beads are also available as Cat. no. A25562.
4] Not used for DNA isolation from buccal swabs.
B Final volume; see “Before first use of the kit: prepare Wash Solutions” on page 23.

[2

Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com.
MLS: Fisher Scientific (www.fisherscientific.com) or other major laboratory supplier.

Table 7 Required materials not included with the kit

Item Source

One of the following instruments

(Recommended) KingFisher™ Flex Magnetic Particle

Cat. No. 5400630
Processor

MagMAX"™ Express-96 Magnetic Particle Processor —M

Equipment

Plate shaker capable of shaking plates at a minimum of

900 rpm MLS

Analog Vortex Mixer Fisher Scientific

02-215-365
Adjustable micropipettors MLS
Multi-channel micropipettors MLS

(Optional but recommended) Magnetic Stand-96 Cat. No. AM10027

Plates and combs

Deep Well Plates, one of the following:

KingFisher" Flex Microtiter Deepwell 96 Plate, Sterile Cat. No. 95040460

MagMAX" Express-96 Deep Well Plates Cat. No. 4388476

Standard Well Plates, one of the following:

KingFisher" 96 KF Microplate Cat. No. 97002540

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide 19


http://www.thermofisher.com
http://www.fisherscientific.com

BT Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit

RS
R Required materials not supplied

(r

Item Source

MagMAX" Express-96 Standard Plates Cat. No. 4388475

Tip Combs, one of the following:

KingFisher™ 96 Tip Comb for DW Magnets Cat. No. 97002534

MagMAX" Express-96 Deep Well Tip Combs Cat. No. 4388487

Other consumables

MicroAmp" Clear Adhesive Film Cat. No. 4306311
RNase-free Microfuge Tubes (2.0 mL]) Cat. No. AM12425
Conical tubes (15 mL) Cat. No. AM12500
Conical tubes (50 mL) Cat. No. AM12502
Aerosol-resistant pipette tips MLS
Reagent reservoirs MLS
(Optional) Paraffin film MLS
Reagents
Ethanol, 200 proof (absolute) MLS
Isopropanol, 100% (molecular grade or higher]) MLS

1" Not available for sale.

Table 8 Additional materials required for buccal swabs

Item Source
Laboratory incubator with slatted shelves capable of MLS
reaching 65°C
One of the following types of buccal swabs, or equivalent buccal swabs with foam tips:
Puritan” PurFlock™ Ultra Flocked Swabs Fisher Scientific

22-025-192

Puritan™ HydraFlock ™ Swabs, standard tip Puritan 25-3306-H
Sterile Foam Tipped Swabs Puritan 25-1506 1PF
4N6FLOQSwabs ™, regular tip Cat. No. 4473979
(Optional) Proteinase K, 500 reactions (4 mL) Cat. No. A25561
(Optional) DNA Binding Beads, 500 reactions (8 mL) Cat. No. A25562
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Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
Download the KingFisher™ Flex program

Table 9 Additional materials required for blood leukocytes

Item Source
Centrifuge capable of spinning deep well plates at 1700 x g MLS
Laboratory incubator with slatted shelves capable of MLS
reaching 65°C
Ammonium Chloride (A.C.S. grade or higher) MLS
EDTA (0.5M), pH 8.0 Cat. No. AM92606G

Download the KingFisher" Flex program

The programs required for these protocols are not pre-installed on the KingFisher -
Flex Magnetic Particle Processor.

1. On the MagMAX™ DNA Multi-Sample Ultra Kit web page, scroll down to the
Product Literature section.

2. Click the appropriate file for your sample type to download the program to your

computer.
Sample type Program
Buccal swabs A25597 Blood_Buccal
Leukocytes A25597_Leukocytes

3. See Thermo Scientific™ KingFisher™ Flex User Manual (Cat. No. N07669) and
BindIt™ Software User Manual (Cat. No. N07974) for instructions for installing the
program on the instrument.
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Set up the sample layout

Set up the sample layout

Set up the sample plate layout using either of the following tools, which provide
sample tracking from the 96-well plate used for DNA isolation to the 96-well sample

™

plate .csv file used for import into OpenArray™ Sample Tracker Software.

Include at least 2 no template controls (NTCs) per plate.

Tool Obtain from Description

OA_Genotyping_CalcSheet | thermofisher.com/oaqrc Contains a sample layout
tab, additional sample
tracking tabs, and
instructions for using an
adjustable pipettor to
transfer samples from the
96-well plate to the 384-well
sample plate.

96-well Sample Plate 1.csv | On the computer on which Contains a sample layout
template the Sample Tracker tab.
Software is installed:

C:\Program Files\Applied
Biosytems\Sample Tracking
Utility\examples

Isolate DNA from buccal swabs

™

This section contains brief procedures. For detailed information, refer to MagMAX
DNA Multi-Sample Ultra Kit (human buccal swabs) User Guide (Pub. no. MAN0010293).

Refer to Best Practices for Collection of Buccal Swabs Quick Reference (Genotyping
Experiments) (Pub. no. MAN0014348) for sample collection instructions.

Guidelines for * Perform all steps at room temperature (20-25°C) unless otherwise noted.
buccal swab ¢ Equilibrate buccal swabs to room temperature to maximize DNA recovery.
preparation * Remove the buccal swabs from the lysate by:

— Option 1: Transfer the lysate to a new plate.
This option eliminates contamination risks and saves time. To transfer
lysates, set a multi-channel micropipettor to ~300 puL and transfer one row at
the time. Each well should contain 200-250 pL after transfer.
— Option 2: Remove the swabs from the plate using forceps.
Rinse the forceps in 70% ethanol between samples, to prevent cross-
contamination. Press the swabs against the side of the well when removing
them, to prevent sample loss.
¢ Cover the plate during the incubation and shaking steps to prevent spill-over and
cross-contamination. The same MicroAmp™ Clear Adhesive Film can be used
throughout the procedure, unless it becomes contaminated.
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Before first use of
the kit: prepare
Wash Solutions

Before each use of
the kit: prepare
DNA Binding Bead
Mix

Digest the
samples with
Proteinase K
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e If you use a plate shaker other than the Thermo Scientific™ Compact Digital

Microplate Shaker, verify that:

— The plate fits securely on your plate shaker.

— The recommended speeds are compatible with your plate shaker. Ideal
shaker speeds allow for thorough mixing without splashing.

* Per-plate volumes for reagent mixes are sufficient for one plate plus overage. To
calculate volumes for other sample numbers, refer to the per-well volume and

add 5% overage.

* (Optional) To prevent evaporation and contamination, cover the prepared
processing plates with paraffin film until they are loaded into the instrument.

¢ This procedure is optimized for processing of one swab per well. It is possible to
process two swabs in one well when a higher concentration of DNA is required.

e If the DNA yield is lower than expected, extend the Proteinase K digestion time

to 45 minutes.

Prepare the Wash Solutions from the concentrates:

* Add 25 mL of isopropanol to Wash Solution 1 Concentrate, mix, and store at

room temperature.

e Add 132 mL of ethanol to Wash Solution 2 Concentrate, mix, and store at room

temperature.

Vortex DNA Binding Beads thoroughly, then combine with Nuclease-free Water

according to the following table.

Component Volume per well Volume per plate
DNA Binding Beads 16 L 1.6 mL
Nuclease-free Water 24 L 2.4 mL
Total DNA Binding Bead Mix 40 L 4 mL

Store DNA Binding Bead Mix at room temperature for up to 24 hours.

Ensure that the incubator is preheated to 65°C.

1. Place the swab, swab-head down, in a well of a MagMAX" Express-96 Deep Well

Plate (one per well).

If two swabs were collected, store the second swab as a backup sample.

2. Break enough of the stick off the swabs so that the swabs sit in the wells without

protruding.

23
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Isolate DNA from buccal swabs

3. Prepare sufficient PK Mix according to the following table. Invert PK Mix several
times to thoroughly mix components.

IMPORTANT! Prepare the PK Mix just before use. Do not place PK Buffer or PK
Mix on ice, to avoid precipitation.

Component Volume per well Volume per plate
Proteinase K 8 uL 800 pL
PK Buffer 192 uL 19.2 mL
Total PK Mix 200 pL 20 mL

4. Add 200 pL of PK Mix to each sample well of a MagMAX"™ Express-96 Deep Well
Plate (PK Plate).

IMPORTANT! Do not touch any part of the swab with the pipet tip when
pipetting the PK Mix in the sample wells.

5. Seal the plate with a MicroAmp™ Clear Adhesive Film and shake the sealed plate
for 5 minutes at 900-950 rpm.

6. Incubate for 20-45 minutes at 65°C.

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the
plate wells, to ensure that samples quickly reach and maintain the incubation
temperature.

1. While the samples are incubating, set up the Wash, Elution, and Tip Comb Plates
outside the instrument as described in the following table.

Plate Volume per
Plate ID positiont! Plate type Reagent well
Wash Plate 1 2 Deep Well | Wash Solution 1 150 pL
Wash Plate 2 3 Deep Well | Wash Solution 2 150 yL
Wash Plate 3 4 Deep Well | Wash Solution 2 150 uL
Elution Plate!? 5 Standard | DA Elution 50 L
Buffer 1
Place a MagMAX" Express-96
Tip Comb 6 Deep Well | Deep Well Tip Comb in a MagMAX™
Express-96 Deep Well Plate.

1 Position on the instrument.

@ The instrument prompts the user to add DNA Elution Buffer 2 to the Elution Plate, after incubation with
DNA Elution Buffer 1.

2. (Optional) To prevent evaporation and contamination, cover the prepared
processing plates with paraffin film until they are loaded into the instrument.
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Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
Isolate DNA from buccal swabs

»;

. (Optional) If condensation is present at the end of the 65°C incubation, briefly

centrifuge the plate for 1-2 minutes at 1500 x g.

. Add 200 pL of Multi-Sample DNA Lysis Buffer to each sample.

. Seal the plate with a MicroAmp™ Clear Adhesive Film and shake for 5 minutes at

speed 8 (900-950 rpm).

. Transfer lysates to the wells of a new MagMAX™ Express-96 Deep Well Plate and

discard the plate containing the buccal swabs.

. Add 240 pL of isopropanol to each sample, seal the plate, and shake for

5 minutes at speed 8 (900-950 rpm).

. Vortex the DNA Binding Bead Mix at moderate speed to ensure thorough

mixing, add 40 pL to each sample, then proceed immediately to DNA isolation
(next section).

If you see that the beads in the DNA Binding Bead Mix are settling, vortex the
mix again briefly before continuing to pipette.

. Select the program on the instrument.

* MagMAX"™ Express-96 Magnetic Particle Processor: 4413021 DW blood
* KingFisher™ Flex Magnetic Particle Processor: A25597_Blood_Buccal

. Start the run, remove the temporary paraffin plate seals (if present), and load the

prepared processing plates in their positions when prompted by the instrument
(see “Set up the processing plates” on page 24).

. Load the PK plate (containing lysate, isopropanol, and DNA Binding Bead Mix)

at position 1 when prompted by the instrument.

. When prompted by the instrument (approximately 28-30 minutes after initial

start):
a. Remove the Elution Plate from the instrument.

b. Add 50 uL of DNA Elution Buffer 2 to each sample well.

IMPORTANT! Add DNA Elution Buffer 2 immediately after the prompt, to
prevent excessive drying of any beads that are still captured on the Tip
Comb.

c. Load the Elution Plate back onto the instrument, and press Start.
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Isolate DNA from blood leukocytes

5. At the end of the run (approximately 30-35 minutes after initial start), remove
the Elution Plate from the instrument and seal immediately with a new
MicroAmp™ Clear Adhesive Film.

* (Optional) Eluates can be transferred to a new storage plate after collection.

e If precipitated DNA is visible, pipet up and down 5-10 times before sealing
the plate, to ensure complete resuspension.

* If excess bead residue is seen in the wells, place the Elution Plate on the
Magnetic Stand-96 to capture any residue prior to downstream use of the
DNA.

IMPORTANT! Do not allow the purified samples to sit uncovered at room
temperature for more than 10 minutes, to prevent evaporation and
contamination.

The purified samples are ready for immediate use. Alternatively, store the covered
Elution Plate:

* At 2-6°C for up to 24 hours.
* At —-20°C or —80°C for long-term storage.

Isolate DNA from blood leukocytes

™

This section contains brief procedures. For detailed information, refer to MagMAX
DNA Multi-Sample Ultra Kit (blood leukocytes) User Guide (Pub. no. MAN0010818).

Guidelines for ¢ If the whole blood is frozen prior to use, thaw the sample at
blood leukocyte 25-37°C in a water bath until it is completely liquid, and place on ice until
needed.

preparation
* Perform all steps at room temperature (20-25°C) unless otherwise noted.

¢ When mixing samples by pipetting up and down, avoid creating bubbles.

¢ Cover the plate during the incubation and shaking steps to prevent spill-over and
cross-contamination. The same MicroAmp™ Clear Adhesive Film can be used
throughout the procedure, unless it becomes contaminated.

* Perform incubation in ice by covering the plate in ice up to the sides without
covering the top of the wells.

¢ Verify that:
— The plate fits securely on your plate shaker.

— The recommended speeds are compatible with your plate shaker. Ideal
shaker speeds allow for thorough mixing without splashing.

* Per-plate volumes for reagent mixes are sufficient for one plate plus overage. To
calculate volumes for other sample numbers, refer to the per-well volume and
add 5% overage.
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Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
Isolate DNA from blood leukocytes

%

Before first use of
the kit

* Prepare the Wash Solutions from the concentrates:
— Add 25 mL of isopropanol to Wash Solution 1 Concentrate, mix, and store at
room temperature.

— Add 132 mL of ethanol to Wash Solution 2 Concentrate, mix, and store at
room temperature.

¢ Prepare 10X Red Blood Cell (RBC) Buffer as indicated in the following table, mix,
and store at 2-8°C.

Component Quantity Final concentration
Ammonium chloride 94 1.68 M
0.5 M EDTA, pH 8.0 400 pL 2mM
Water up to 100 mL —
Total 10X RBC Buffer 100 mL —

Before each use of
¢ Preheat the incubator to 65°C.

the kit
* Prepare fresh 1X RBC Buffer as indicated in the following table, mix, and store on
ice until use.
Component Volume per well Volume per plate

10X RBC Buffer 60 pL 6 mL

Water 540 pL 54 mL

Total 1X RBC Buffer 600 pL 60 mL
Lyse the red blood 1. Invert the collection tube 5 times to ensure thorough mixing of the sample.

cells and pellet

the leukocytes 2. Transfer 200 uL of whole blood to each sample well.

3. Add 600 pL of ice-cold 1X RBC Bulffer to each sample and mix by pipetting up
and down 10 times with a multi-channel micropipettor.

4. Seal the plate with a MicroAmp™ Clear Adhesive Film.

5. Submerge the plate in ice that is halfway up the side of the plate, then incubate
15 minutes. Mix briefly twice during the incubation by shaking the plate for 15
seconds at 900-950 rpm.

Note: The cloudy suspension becomes translucent during incubation, indicating
lysis of the erythrocytes.

6. Centrifuge at >1700 x g for 15 minutes.
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| /solate DNA from blood leukocytes

7. Carefully remove and discard the supernatant (~700 uL) without disturbing the

leukocyte pellet.

Note: Up to 100 pL of supernatant can be left in the well to avoid loss of sample.
When removing the supernatant, aspirate from the side of the well, not the
center.

8. Seal the plate with the MicroAmp™ Clear Adhesive Film, then place on ice.

Digest the Ensure that the incubator is preheated to 65°C.

samples with 1
Proteinase K

. Prepare sufficient PK Mix according to the following table. Invert PK Mix several

times to thoroughly mix components.

IMPORTANT! Prepare the PK Mix just before use. Do not place PK Buffer or PK
Mix on ice, to avoid precipitation.

Component Volume per well Volume per plate
Proteinase K 0.8 pL 80 pL
PK Buffer 4.2 uL 420 pL
Total PK Mix 5.0 uL 500 pL

Add 5 pL of PK Mix to each sample well and mix by pipetting up and down
5 times with a multi-channel micropipettor.

Seal the plate with a MicroAmp™ Clear Adhesive Film and shake the sealed plate
for 5 minutes at 900-950 rpm.

Incubate for 15 minutes at 65°C.

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the
plate wells, to ensure that samples quickly reach and maintain the incubation
temperature.

During the incubation at 65°C, follow “Set up the processing plates” on
page 29.

Proceed immediately to “Add Multi-Sample DNA Lysis Buffer, Bead/RNase A Mix,
and isopropanol” on page 29.
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Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
Isolate DNA from blood leukocytes
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Set up the 1. During the incubation at 65°C, set up the Wash, Elution, and Tip Comb Plates
processing plates outside the instrument as described in the following table.

Table 10 Processing plates

Plate Volume per
Plate ID positionti] Plate type Reagent well
Wash Plate 1 2 Deep Well | Wash Solution 1 150 pL
Wash Plate 2 3 Deep Well | Wash Solution 2 150 pL
Wash Plate 3 4 Deep Well | Wash Solution 2 150 pL
Elution Plate? 5 Standard | D'VA Elution 50 pl
Buffer 1
Place a MagMAX™ Express-96
Tip Comb 6 Deep Well | Deep Well Tip Comb in a MagMAX™
Express-96 Deep Well Plate.

1 Position on the instrument

21 The instrument prompts the user to add DNA Elution Buffer 2 to the Elution Plate, after incubation with
DNA Elution Buffer 1.

2. (Optional) To prevent evaporation and contamination, cover the prepared
processing plates with paraffin film until they are loaded into the instrument.

Add Multi-Sample 1. Add 400 pL of Multi-Sample DNA Lysis Buffer to each sample and mix by

DNA Lysis Buffer pipetting up and down 5 times with a multi-channel micropipettor.

B?ad/ RNase A 2. Seal the plate with a MicroAmp™ Clear Adhesive Film, then shake for 5 minutes
Mix, and at 900-950 rpm.

isopropanol

3. Prepare Bead/RNase A Mix according to the following table.

IMPORTANT! Prepare the Bead/RNase A Mix up to 20 minutes before use.
Prolonged storage at room temperature can reduce its efficiency.

Vortex the DNA Binding Beads at moderate speed to form a uniform suspension

before pipetting.
Component Volume per well Volume per plate
DNA Binding Beads 16 uL 1.6 mL
RNase A 5puL 500 pL
Nuclease-free Water 19 pL 1.9 mL
Total Bead/RNase A Mix 40 pL 4 mL

4. Vortex the Bead/RNase A Mix at moderate speed to ensure thorough mixing,
then add 40 uL to each sample, then use a multi-channel micropipettor to mix by
pipetting up and down 5 times.

If you see that the beads in the Bead/RNase A Mix are settling, vortex the mix
again briefly before continuing to pipette.

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide 29



o

=y
(O]

>

Process samples
on the instrument

30

2 Chapter 3 Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
"4 Isolate DNA from blood leukocytes

5. Seal the plate with the MicroAmp™ Clear Adhesive Film and shake for 5 minutes
at 900-950 rpm.

6. Add 240 pL of isopropanol to each sample, briefly shake for 30 seconds at 900-
950 rpm, then proceed immediately to process the samples on the instrument
(next step).

-_

Select the program A25597_Leukocytes on the instrument.

™

If you are running your samples on the MagMAX™ Express-96 Magnetic Particle
Processor, use the program 4413021_DW_blood

2. Start the run, remove the temporary paraffin plate seals (if present), and load the
prepared processing plates to their positions when prompted by the instrument
(see Table 10).

3. Load the sample plate (containing lysate, isopropanol, and Bead/RNase A Mix)
at position 1 when prompted by the instrument.

4. When prompted by the instrument (approximately 23 minutes after initial run):

a. Remove the Elution Plate from the instrument.

b. Add 50 uL of DNA Elution Buffer 2 to each sample well.

IMPORTANT! Add DNA Elution Buffer 2 immediately after the prompt, to
prevent excessive drying of any beads that are still captured on the Tip
Comb.

c. Load the Elution Plate back onto the instrument, and press Start.

5. At the end of the run (approximately 27 minutes after initial start), remove the
Elution Plate from the instrument and seal immediately with a new MicroAmp™
Clear Adhesive Film.

* If precipitated DNA is visible, pipet up and down 5-10 times before sealing
the plate, to ensure complete resuspension.

* (Optional) Eluates can be transferred to a storage plate after collection.

* If excess bead residue is seen in the wells, place the Elution Plate on the
Magnetic Stand-96 to capture any residue prior to downstream use of the
DNA.

IMPORTANT! Do not allow the purified samples to sit uncovered at room
temperature for more than 10 minutes, to prevent evaporation and
contamination.

The purified samples are ready for immediate use. Alternatively, store the covered
Elution Plate:

e At 2-6°C for up to 24 hours.
* At -20°C or -80°C for long-term storage.
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DNA concentration and quantification

We recommend that you prepare 50 ng/puL DNA stock solutions for 825 pg
DNA/33 nL SNP genotyping reaction.

Note: Samples with low concentration (<10 ng/uL) or PCR inhibitors may fail to
amplify and/or cluster properly, and can yield inaccurate results.

Quantify DNA by any of the following methods. Before quantifying, mix the samples
well to ensure sample homogeneity, especially if samples have been stored.

* RNase P Ct value method (recommended) — See Appendix A, “RNase P
Quantification for genotyping experiments”

e UV absorbance measurements — Use a NanoDrop™ or other comparable
instrument. Pure gDNA should have an Ajqy/Ajgp ratio of approximately 1.8-2.0.

e Fluorometric analysis — Use a Qubit™ dsDNA BR or HS Assay Kit.
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Prepare and run OpenArray CFTR

SNP genotyping experiments

WOrKflow ... 33
Required materials: OpenArray™ plate workflow ........................ 33
Generate 384-well sample plate layouts in OpenArray™ Sample

Tracker Software .......... ... 34
Set up the PCR reactions in the 384-well plate for AccuFill™

system transfer ... .......... .. 35
Set up the AccuFill™ instrument ........... ... o i i 36
Transfer reactions to the OpenArray™ plate in the AccuFill™ instrument .... 37
Seal the OpenArray™ plate .. ...ttt 38
Run the OpenArray™ plate(s) on the QuantStudio™ 12K Flex instrument . ... 39
Checkthe QCImages ... 40
To recover from layout errors in the 384-well sample plate . ................ 40
One-time procedures ........... ... ... .. . 41

This chapter contains brief procedures. For detailed procedures, refer to:

Title Pub. no.
QuantStudio” 12K Flex Real-Time PCR System: 4470935
OpenArray  Experiments User Guide
OpenArray” Sample Tracker Software Quick Reference 4460657
OpenArray” AccuFill" System User Guide 4456986
TagMan™ OpenArray” Genotyping Troubleshooting Guide MANOO11115
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ments
Workflow

Workflow

“Generate 384-well sample plate layouts in OpenArray” Sample Tracker
Software” on page 34

v

“Set up the PCR reactions in the 384-well plate for AccuFill™ system
transfer” on page 35

v

“Set up the AccuFill" instrument” on page 36

v

“Transfer reactions to the OpenArray” plate in the AccuFill"
instrument” on page 37

v
“Seal the OpenArray" plate” on page 38

v

“Run the OpenArray" plate(s) on the QuantStudio™ 12K Flex
instrument” on page 39

v
“Check the QC Images” on page 40

v

“Analyze results in TagMan" Genotyper Software” on page 44

Required materials: OpenArray" plate workflow

Unless otherwise indicated, all materials are available through thermofisher.com.
MLS: Fisher Scientific (www.fisherscientific.com) or other major laboratory supplier.

Item Source

Genomic DNA We recommend that you prepare 50 ng/pL DNA stock
solutions for 825 pg DNA/33 nL SNP genotyping reaction.

From Chapter 3, “Isolate DNA using the MagMAX" DNA
Multi-Sample Ultra Kit"

(Optional) CFTR TagMan™ Assay Controls A30421
OpenArray” 384-Well Sample Plates (microplates), black 4482221
OpenArray” plates with CFTR assays Custom ordered
TagMan" OpenArray” Genotyping Master Mix (5 mL) 4404846

Biomek Seal and Sample Foil Lids (for pre-plating step) Beckman Coulter 538619
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Generate 384-well sample plate layouts in OpenArray™ Sample Tracker Software

2 carriers)

(contains the items needed to assemble up to 10 plates:
12 lids and plugs, 12 immersion fluid syringes, and

ltem Source
OpenArray” AccuFill™ System Tips 4458107
QuantStudio™ 12K Flex OpenArray” Accessories Kit 4469576

Instruments and software required:

OpenArray  Sample Tracker Software
QuantStudio™ 12K Flex OpenArray  Plate Press 2.0.
QuantStudio " 12K Flex instrument with OpenArray " block (AccuFill " System)

Generate 384-well sample plate layouts in OpenArraym Sample
Tracker Software

34

The

software maps samples from the 96-well layout used for DNA isolation to a

384-well sample plate layout as .csv files that are used by OpenArray = AccuFill
software.

See “One-time procedures” on page 41 to:

Set up optimized folder locations and software preferences before performing
this procedure for the first time.

Download the SPF file(s) for the OpenArray  plate(s) before starting.

. Generate the 96-well sample plate .csv file using the OA_Genotyping_CalcSheet

or 96-Well Sample Plate 1.csv template, then save it to the Sample Tracker 96-well
Input folder.

The 96-Well Sample Plate 1.csv file is provided in the AccuFill™ software
installation. Enter or copy the sample names in 96-Well Sample Plate 1.csv, then
Save as a new .csv-format file.

The OA_Genotyping_CalcSheet automatically generates the sample .csv file.

In the Sample Tracker Software Properties page, select Genotyping for
Experiment Type, then select the appropriate settings for OpenArray ™ Plate and
Pipettor.

In the Samples page, click & Import, then select and import the sample .csv file.

In the Sample Mapping page, confirm that the samples for a single OpenArray™
plate are assigned to one color.

If necessary, correct the OpenArray ™ Plate and Pipettor settings in the Properties
page.

In the Sample Mapping page, click the 384-Well Plate tab, then click
Export » Export *.csv.

Select 384-Well Plate (for AccuFill), then save the exported file.
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Plate layouts for the 384-well sample plates are saved to individual .csv files in the
Sample Tracker 384-well CSV Files folder.

Set up the PCR reactions in the 384-well plate for AccuFill" system

transfer

For best results, dilute DNA samples to 50 ng/uL before setting up the PCR reactions.

IMPORTANT! The 4 x 12 area(s) of the 384-well plate being filled must match the
area(s) designated in Sample Tracker Software for that set of samples.

1.

Remove the OpenArray ™ plate from the freezer and allow it to thaw in its sleeve,
unopened, at room temperature (~15 minutes).

The OpenArray ™ plate must be completely thawed before transferring reactions
to it from the 384-well plate.

Mix the 2X Master Mix gently. Do not invert the bottle.

Vortex the Assay Working Stock, then centrifuge briefly.

Following the plate layout determined in Sample Tracker Software, add master
mix, then UltraPure™ DNase/RNase-Free Distilled Water (NTCs) or DNA

samples, to a 384-well microplate (OpenArray™ 384-Well Sample Plate). Include 2
NTCs on each plate.

OpenArray” Genotyping Plate Format
Component
16 32 64 +
TagMan" OpenArray™ 1.5yl 2.0pL 2.5puL
Genotyping Master Mix
One of the following: 1.5uL 2.0 L 2.5l
o UltraPure" DNase/RNase-
Free Distilled Water (NTCs)
e DNA sample
Total reaction volume 3.0yl 4.0 L 5.0uL

Seal the plate with an aluminum foil seal, remove the foil flap, mark the edges of
the filled 4 x 12 area with a pen, then score the foil along those lines.

Do not remove the foil from the scored area at this time.

Vortex the sealed plate for 5 seconds, then centrifuge the plate for 1 minute at
1,000 rpm.

Vortex gently to avoid bubble formation.
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Set up the AccuFill™ instrument

If you make a sample layout error:

* Before the AccuFill" procedure — Repeat “Generate 384-well sample plate layouts
in OpenArray  Sample Tracker Software” on page 34 with a corrected sample.csv
file.

e After the AccuFill" procedure — See “To recover from layout errors in the 384-
well sample plate” on page 40.

Set up the AccuFill” instrument

IMPORTANT! Before proceeding, check the tip expiration date (shown on the outer
box that contains the trays of tips). Do not use tips that exceed the expiration date.

1. In the OpenArray™ AccuFill™ software, click Setup and Load.

2. In the Setup Load Information window, verify that the Use Sample Integration
checkbox is selected.

Setup Load Information

Loading information

Specify the type of load you want to perform. Enter Plate and OpenArray® Plate barcodes by
scanning them, typing them, or selecting the associated file.

Use Sample Integration Samples Per Subarray
Sample Plate I:I Plate Holder Position 1 ABC12

Plate Holder Position 2

Plate Holder Position 3
Flate Holder Position 4

1

Select Samples to Load

Click the section on the sample plate frarm which the first sample will be extracted. The image on the
tight shows how the sample will be applied to the OpenArray Plates.

Plate Holder Position 1

ABCTZ

late Holder Position 2

L

late Holder Position 3

[Hmmm

late Holder Position 4
Sample section{s) already used: 1 on 2/1:2012

[Hmmm —

Mext = l l Cancel
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Click Browse to the right of Sample Plate, then select the 384-well sample
plate .csv file that was generated with Sample Tracker Software.

Click Browse to the right of the plate holder position corresponding to the
OpenArray™ of interest, then select the .spf file corresponding to the desired
OpenArray™ plate.

Click the corresponding 4 x 12 area of the 384-well plate, then click Next to open
the Setup Deck window.

Ensure that:

* Tip boxes are loaded in the AccuFill™ instrument in the displayed
configuration.

* Lids are removed from the tip boxes.

* The waste bin in the instrument is emptied.

In the Setup Deck window:
a. Click the The tips are configured as shown above checkbox.

b. Click the The Waste Bin is empty checkbox.

Transfer reactions to the OpenArray " plate in the AccuFill”

instrument

Ensure that the OpenArray  plate is thoroughly thawed before starting this
procedure.

1.

Prepare the items needed to seal the OpenArray™ plates (next section), because

™

the OpenArray " plate must be sealed promptly after being loaded with the
reactions (this section).

a. Ensure that the QuantStudio™ OpenArray™ Plate Press is ready.

™

b. Gather and remove from its packaging an OpenArray " Lid, plug, syringe
with OpenArray™ Immersion Fluid, and syringe tip.

c. Attach the syringe tip to the syringe and carefully push some of the fluid
through the tip to remove air bubbles, then lay the syringe aside.

Remove the OpenArray ™ plate from its sleeve and place it in the Plate Holder of
the AccuFill™ instrument.

Ensure that the bar code on the OpenArray™ plate is facing left and the serial
number is facing right.

Using forceps, peel off the foil over the 384-well plate area being used.
Close the instrument door.

In the AccuFill™ software Setup Deck window:
a. Click the The OpenArray Plate is in the Plate Holder checkbox.
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Seal the OpenArray™ plate

b. Click the Remove foil from the highlighted section of the Sample Plate
checkbox.

c. Click Load.

6. As soon as the Remove OpenArray Plate window appears (after ~90 seconds),
open the instrument door, and remove the loaded OpenArray™ plate.

7. Proceed immediately to seal the OpenArray™ plate (next section).

Note: For best results, seal the OpenArray™ plate within 90 seconds of
completion of loading, to prevent evaporation.

Seal the OpenArray’ plate

IMPORTANT! Handle the OpenArray  plate and case only by the edges throughout
this procedure.

1. Place the filled OpenArray™ plate in the QuantStudio™ 12K Flex OpenArray™
Plate Press 2.0.

Ensure that the bar code is facing left and the serial number is facing right.

2. Remove the clear plastic sheets from the top and the bottom of the lid, remove
the red protective film around the edge of the OpenArray™ lid, then seat the lid
on the OpenArray™ case in the plate press.

-

(D Protective film (remove)

(@ Adhesive

(3 Protective film (remove)

(® Notched end (align with serial number)

3. Engage the press mechanism until the green flashing light changes to a steady
green light (~20 seconds).

4. Disengage the press, then remove the OpenArray™ case.
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5. While holding the OpenArray™ case by the edges, insert the prepared syringe tip
into the port in the case and carefully inject immersion fluid until the case is
filled.

It is important that the syringe tip is in front of the array when filling the case with
immersion fluid.

Minimize creation of air bubbles when you dispense the fluid; one small air
bubble in the case is acceptable.

6. Continuing to hold the case vertically, remove the syringe tip, insert the screw
end of the OpenArray™ Plug into the port and rotate clockwise until the black
handle breaks off.

7. Clean the case with a laboratory wipe that has been thoroughly sprayed with
ethanol, then dry the case with a clean laboratory wipe.

Run the OpenArray " plate(s) on the QuantStudio 12K Flex
instrument

1. On the instrument touchscreen, touch g to extend the loading arm, and place

™

the OpenArray ™ plate(s) on the plate adapter.

Ensure that the plate barcode and serial number are facing the front of the
instrument.

2. Touch g to retract the loading arm.

3. On the Home screen of the QuantStudio™ 12K Flex Software, select
Run » OpenArray.

4. In the Select Instrument pane, select the QuantStudio™ instrument.

5. Click Get Plate IDs to import the barcode(s) of the OpenArray™ plate(s).

Once the OpenArray ™ serial numbers appear, the loaded .spf files corresponding
to each plate should appear in the Setup File field.

If not, click Browse, then select the correct loaded .spf file from the Loaded SPF
folder.

6. (Optional) If desired, click Browse to change the QuantStudio™ Experiment File
Location.
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7. (Optional) If desired, change the software-determined Experiment File Name.

8. On the instrument touchscreen, touch Start Run.

The instrument pauses at 41 or 42 seconds prior to the end of the run. Wait for
the system to complete the run before opening the .eds file.

9. Transfer the .eds file from the instrument to an accessible location for analysis in
Genotyper Software.

10. Check the QC images for loading issues or leaks; see “Check the QC Images” on
page 40.

Check the QC Images

Check the QC images before analysis in Genotyper Software. For additional
information, see the TagMan' OpenArray" Genotyping Troubleshooting Guide
(Pub. no. MANO0011115).

1. In the instrument software Export tab, set a uniquely named folder for the
OpenArray™ plate of interest, then click Export QC Images.

2. View POST-READ_CHANNEL_4.tiff (ROX™ image), to check for loading quality
issues.

3. View s03_c001_t02_p0001_m2_x3_el_cp#_spotfind.tiff for leaks or other
displaced sample issues.
cp# identifies in which position in the instrument an array was run.

If a problem is found, view s01_c001_t02_p0001_m2_x3_el_cp#_spotfind.tiff to
see if the issue existed even before cycling (this is useful for troubleshooting).

4. View STAGE3_CYCLE1_CHANNEL_1.tiff and
STAGE3_CYCLE1_CHANNEL_2.tiff to check for any fluorescent abnormalities,
and to confirm any problem seen in the spotfind image.

5. Note any abnormalities found, as well as all other potentially relevant
information related to the setup of the run.

To recover from layout errors in the 384-well sample plate

After the AccuFill™ procedure, you can recover from plate layout errors that were
made during setup of the reactions in the 384-well sample plate. Refer to the
OpenArray™ Sample Tracker Software Quick Reference (Pub. no. 4460657) for additional
information.

1. Create a corrected sample .csv file.

2. Repeat “Generate 384-well sample plate layouts in OpenArray™ Sample Tracker
Software” on page 34, but select OpenArray Plate X (for QuantStudio) when
exporting from Sample Tracker Software.

™

3. Import the corrected .csv file into the QuantStudio™ 12K Flex Software.
You can import either before starting the run or after the run is complete.
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AccuFill™ software:
e SPF Files

ments
One-time procedures

This procedure simplifies the file locations used in the OpenArray ~ AccuFill "
instrument software.

Set up the default file locations and preferences before using the OpenArray
AccuFill" system for the first time. You must be logged in as an administrator.

. Create four folders in a convenient location on the same computer drive as the

¢ Sample Tracker 96-well Input
* Sample Tracker 384-well CSV Files

e Loaded SPF Files

2. (Optional; not required if using the OA_Genotyping_CalcSheet.) Navigate to

<drive>:\Program files (x86) \AppliedBiosystems\OpenArray
Sample Tracker\Examples, copy 96-Well Sample Plate 1.csv, then paste it in
the Sample Tracker 96-well Input folder.

. In OpenArray™ Sample Tracker Software, select View » Preferences, and enter
preferences as indicated.

Field

Selection

Experiment type

Genotyping

OpenArray Plate

Select the OpenArray" format that will be run most
often, for example, Genotyping - 64

Pipettor

Adjustable or Fixed

Import Data Directory

Sample Tracker 96-well Input folder

Export Data Directory

Sample Tracker 384-well CSV Files folder

. In the AccuFill™ software, select Instrument » Edit Preferences, then:

a. Click the Require Sample Integration checkbox.

b. Select the indicated folders.

folder...

For this AccuFill™

Select this folder... Folder contents

OpenArray" Plate
File Input Folder

SPF Files .spf files for your
OpenArray” plates; contain
assay name and location

Plate File Folder

Sample Plate File Sample Tracker 384-well .csv 384-well sample plate
Folder CSV Files layout files
Loaded OpenArray" |Loaded SPF Files Integrated .spf files that are

generated during
processing with AccuFill™
Software.
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files
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5. In the QuantStudio™ 12K Flex instrument software, select

Tools » Preferences » OpenArray, then select the Loaded SPF Files folder for the
software Setup Folder.

Note: If the instrument software is not on same computer as the AccuFill™

software, you will need to transfer the loaded SPF files to the computer running
the instrument software.

Set up the optimized folder locations and software preferences before downloading
SPF files. See “Set up default folders and software preferences” on page 41.

For custom OpenArray  plates, have the sales order number, lot number, and serial
number for each plate ready.

* The sales order number is located on the packing slip and order confirmation
email.

e The lot number and serial number are found on the pouch of each OpenArray
plate.

1. At www.thermofisher.com/OA-platefiles, select TagMan™ OpenArray ~ Custom

Genotyping Plates QuantStudio 12K Flex in the Select Your Product dropdown
list.

Note: Do not choose from the bottom half of the dropdown list, under
OpenArray™ Real Time PCR Platform.

2. Select I want to download all available SPF & AIF files or I want to download a
specific SPF file, enter the sales order number, lot number, and serial number, as

required, then click Submit.

3. Save the SPF file(s) to the desktop SPF Files folder.
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Analysis options for CFTR genotypingdata ..............................

Analyze results in TagMan" Genotyper Software ........................

Analyze data in QuantStudio™ 12K Flex or Thermo Fisher Cloud

Cloud software ........

Analysis guidelines: SNP genotyping assays to triallelicSNPs ..............

Analysis guidelines: SNP genotyping assays to regions with

multiple mutations

B Analysis guidelines: SNP genotyping assays to the

5T/7T/9T polymorphism

B Analysis guidelines: SNP genotyping assays to large CFTR mutations .. .....

This chapter contains brief procedures. For detailed information, refer to TagMan'

M

Genotyper Software Getting Started Guide (Pub. no. 4448637).

Analysis options for CFTR genotyping data

Analyze allelic discrimination plots for CFTR genotyping data using any of these

tools:

Analyze CFTR genotyping data

Software

Features

TagMan™ Genotyper
software

Desktop software
Create studies

Overlay data from multiple plates

QuantStudio™ 12K Flex
software

Desktop software

View real-time trace data that is needed for positive
result confirmation

Thermo Fisher Cloud GT
Analysis module

Cloud software
Create studies
Overlay data from multiple plates

View real-time trace data that is needed for positive
result confirmation
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Analyze results in TagMan" Genotyper Software

For non-standard assays, review the data for both assays together to ensure accurate
genotyping results.

Confirm all positive results as described in the next chapter.

1.

10.

1.

12.

In Genotyper Software, click Create Study from Template, then select and open
the desired template (.lat).

Note: If you have not created a template, see “Create a study template” on
page 45.

In the Workflow Menu pane, select Setup » Experiments.

Click Import, then select and import one or more OpenArray ™ experiment files

(.eds).

Ensure that the Use Hardy-Weinberg for Analysis option is selected in the
Analysis Settings.

Click Analyze.
Inspect the call data for the SNP assay in the scatter plot.

(Optional) If desired, manually assign the genotype: select the sample(s), right-
click, then select the genotype.

Select the Inspected checkbox next to the assay, then click Save.
Repeat the inspection for each SNP assay.
In the Workflow Menu pane, select Export » Analysis Data.

In the Export Study Properties pane:
* Select Analysis Results » Advanced.
¢ Select One File.

¢ Enter the filename and location, and select (*.txt).

Click Export preview, then click Start Export in the new window.
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Create a study template

If you will use a Reference Panel, generate the Reference Panel before creating the
study template, so that the Reference Panel can be imported into the template.

If necessary, first download the Assay Information File (AIF) from
www.thermofisher.com/OA-platefiles.

1. In the TagMan"™ Genotyper Software Home screen, click Create Study.

2. In the Workflow Menu pane, select Setup » Properties, then enter the study
properties.

e For Instrument Type, select QuantStudio™ 12K Flex Real-Time PCR
System.

e For Experiment Type, select Real-time.
3. In the Workflow Menu pane, select Setup » Assays.
4. Click Import, then select and import the Assay Information File (AIF).

5. (Optional) Import the Reference Panel:
a. In the Workflow Menu pane, select Setup » References.

b. Click Import, then select and import the Reference Panel file of interest.

6. Select File » Generate Template, enter a template name (.edt), then save the
template in the desired location.
(Optional) Generate a Reference Panel

A reference panel consists of high-quality data for all the assays in the study. The data
can be chosen from multiple OpenArray = plates.

For best results, generate a new Reference Panel for each lot of OpenArray  plates.

If necessary, first create a study containing data that will be used as reference samples.
Set QuantStudio™ 12K Flex Real-Time PCR System for Instrument Type, and Real-
time for Experiment Type in the study properties.

1. In TagMan™ Genotyper Software, open the study that contains data points to be
used as reference samples.

2. In the Workflow Menu pane, select Analysis » Results.

3. Click-drag in the scatter plot to select one or more data points.

™ ™

Select data points for each homozygous genotype (FAM™ dye-labeled or VIC
dye-labeled) and the heterozygous genotype.

The non-selected data points will fade.
4. Right-click in the scatter plot, then select Tag for Ref Panel.

5. Repeat the selection and tag steps for additional data points.
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6. Confirm that the correct samples have been tagged as reference samples in the
Results table.

In the Results tab, Reference Sample must be checked in the View dropdown list
to view the tags.

7. Repeat the data point selection, tag, and confirmation steps for each SNP assay of
interest.

8. Select File » Save.

9. Select File » Generate Reference Panel, enter a name for the panel and save the
file (lap) to the desired location.
(Optional) Add samples to an existing Reference Panel

During analysis in Genotyper Software, you can add samples to an existing Reference
Panel.

The Reference Panel must already be imported into the study containing samples that
will be added to the Reference Panel.

1. In the scatter plot of the study, select data points for the samples of interest, right-
click in the plot, then select Tag for Ref Panel.

2. Select File » Save.

3. Select File » Generate Reference Panel, enter a name for the panel and save the
file (.lap) to the desired location.

Analyze data in QuantStudio” 12K Flex or Thermo Fisher Cloud

Cloud software

For non-standard assays, review the data for both assays together to ensure accurate
genotyping results.

Confirm all positive results as described in the next chapter.

™

To use the QuantStudio™ 12K Flex software or related instrument software:

* In analysis settings, select Analyze Real-Time Rn — Median (Rna to Rnb). This
setting will normalize for any run and system noise to improve data accuracy.

* Select Analysis » Allelic Discrimination Plot.

To use the Thermo Fisher Cloud GT Analysis module:
* Go to www.thermofisher.com/us/en/home/cloud.html
e Create a project and import one or more OpenArray" experiment files (.eds).
* Access the Genotyping (GT) module.
* Analyze data.
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Analysis guidelines: SNP genotyping assays to triallelic SNPs

Allele I FAM (8)

Figure 1

E92K c.274G=A

Several important CFTR mutations are triallelic SNPs (three bases occur at the same
genomic location). Triallelic SNP alleles are interrogated using two TagMan  assays.

Example
* Assay 1: Wild type T, Mutant A [non-target mutant allele for Assay 2]
* Assay 2: Wild type T, Mutant G [non-target mutant allele for Assay 1]

Expected results

Always examine data for both assays to ensure correct genotyping results.

¢ Samples that are heterozygous for a mutation run as heterozygous with the assay
designed to that mutant allele and typically run with the wild type samples in the
second assay (because only the wild type allele is detected in the second assay).

* Some assays exhibit nonspecific probe activity for the nontarget mutant allele,
and heterozygous samples containing the nontarget mutant allele can be
incorrectly called as heterozygous for the target mutant allele.

Example data

The following figures show example OpenArray  data generated using wild type
genomic DNAs and synthetic heterozygous mutation controls for four pairs of
triallelic SNP assays. In each pair, one assay shows nonspecific probe activity for the
nontarget mutant allele. The result for the heterozygous control sample containing the
nontarget mutant allele is circled in each data plot.
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Triallelic SNP rs121908751 assay results. Left: E92K ¢.274G>A assay (C_32545261C_10) to the G wild type

and A mutant allele; the mutant allele probe is specific and the heterozygous sample containing the nontarget T allele
runs with wild type samples. Right: E92X ¢.274G>T assay (C_32545261D_20]) to the G wild type and T mutant allele;
nonspecific probe activity is observed for the nontarget A allele. Without evaluation of data for both assays together,
the G/A sample could be incorrectly called as a G/T heterozygote.
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Figure 2 Triallelic SNP rs121908761 assay results. Left: Y1092X(C->G) ¢.3276C>G assay (C_26083714D_20) to the C
wild type and G mutant allele; the mutant allele probe is specific and the heterozygous sample containing the
nontarget A allele runs with wild type samples. Right: Y1092X(C->A) ¢.3276C>A assay (C_26083714C_10] to the C wild
type and A mutant allele; nonspecific probe activity is observed for the nontarget G allele. Without evaluation of data
for both assays together, the C/G sample could be incorrectly called as a C/A heterozygote.
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Figure 3 Triallelic SNP rs77932196 assay results. Left: R347H c.1040G>A assay (C___ 656878D_20) to the G wild type
and A mutant allele; the mutant allele probe is specific and the heterozygous sample containing the nontarget C allele
runs with wild type samples. Right: R347P ¢.1040G>C assay (C___656878C_30) to the G wild type and C mutant allele;
nonspecific probe activity is observed for the nontarget A allele. Without evaluation of data for both assays together,
the G/A sample could be incorrectly called as a G/C heterozygote.
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Figure 4 Triallelic SNP rs80055610 assay results. Left: R560T ¢.1679G>C assay (C_27861436C_30) to the G wild type
and C mutant allele; the mutant allele probe is specific and the heterozygous sample containing the nontarget A allele
runs with wild type samples. Right: R560K c.1679G>A assay (C_27861436D_20) to the G wild type and A mutant allele;
nonspecific probe activity is observed for the nontarget C allele. Without evaluation of data for both assays together,
the G/C sample could be incorrectly called as a G/A heterozygote.

Analysis guidelines: SNP genotyping assays to regions with multiple

mutations

Some qualified CFTR mutation assays cover probe-binding sites that contain one or
more mutations that are close to the target mutation. These nearby nontarget
mutations do not typically interfere with genotype analysis of the target mutation in
heterozygous samples because these rare mutations are not found together in cis on
the same chromosome. For example, the F508del assay does not detect the 1507del

mutation.

Expected results

e A sample that is heterozygous for a target mutation:

— Runs as a heterozygous sample with the assay to the target mutation.

— Runs with wild type samples with an assay to a nearby mutation. The signal
for the heterozygous mutation sample may be lower than the signal for wild
type samples because only one chromosome (wild type) is detected.

¢ A sample that is homozygous for a target mutation:

— Runs as a homozygous mutation sample with the assay to the target
mutation.

— Is not detected by assays to nearby mutations and runs with or near the
NTCs.

* A sample that contains two nearby mutations on different chromosomes (for
example, a compound heterozygote):

— Runs as a homozygous mutant with the assays that target each mutation
(wild type probes cannot bind).

— Is not detected by assays to other nearby mutations.
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Always examine data for all assays to ensure correct genotyping results.

Example data F508del region

Figure 5 and Figure 6 show OpenArray  data for the F508del region, which contains
five mutations that are covered by qualified TagMan SNP genotyping assays:

¢ Samples that contain the F508del, 1507del, and F508C mutations are detected by
their respective assays (Figure 5 A, B, and C).

* Samples that are homozygous for the F508del mutation do not amplify with
assays designed to the nearby mutations; they run close to the NTCs (Figure 5 A
through D and Figure 6).

* Heterozygous samples tested with assays to nearby mutations may show lower
signal than other samples in the wild type cluster (Figure 6)
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Figure 5 F508del region assay results: (A] F508del (C_151693869_10) (B) 1507del (C_151693868_10), (C) F508C
(C_100964862_10), (D) 1506V (C__59055679_20). Two F508del mu/mu homozygous mutation samples are circled in
each data plot. Heterozygous 1507del and F508C samples are shown in (B) and (C). [Samples: Coriell cell line gDNA
(not available for 1506V]]
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Figure 6 F508del region assay results: (E) 1507V (C___8853252_20). Two F508del mu/mu
homozygous mutation samples are circled. The approximate positions of the F508del,
I1507del, and F508C heterozygous samples in the 1507V assay wild type cluster are shown in
(E). [Samples: Coriell cell line gDNA (not available for 1507V]]
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Example data 2184delA region

Figure 7 shows OpenArray  data for the 2184delA region, which contains four
mutations that are covered by qualified TagMan'~ SNP genotyping assays:

¢ Samples that contain the 2184delA and 2183A A>G mutations are specifically
detected by their respective assays (Figure 7 A, B).

* A small amount of nonspecific probe activity for the 2184delA heterozygous
samples may be observed with the 2184delA and 2183delAA assays, and signal
may be lower than signal for other samples in the wild type cluster (Figure 7 B
and C).

Note: Data is not shown for the 2184insA assay, which is not recommended for
OpenArray  plate format.
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Figure 7 2184delA region assay results. (A) 2184delA (C_172767547_20 ), (B) 2183AA->G (C172767555C_30), (C)
2183delAA (C172767555D_20 ). Heterozygous 2184delA and 2183AA->G samples identified by specific assays are
indicated in (A) and (B); 2184delA heterozygous samples in the wild type cluster of the 2183AA->G and 2183delAA
assays are shown in (B) and (C), respectively. [Samples: Coriell cell line gDNA (not available for 2184delAA]]
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Analysis guidelines: SNP genotyping assays to the 5T/7T/9T
polymorphism

Each of the two assays used to interrogate the triallelic polyT variant contain one
probe to the wild type 7T allele and one probe to one of the mutant alleles (5T or 9T).
Because of nonspecific activity, the 7T probe in the 5T assay cannot distinguish 7T and
9T alleles, but this does not interfere with genotype analysis.

Expected results
Always examine data for both assays to ensure correct genotyping results.

The following translation table lists possible assay results and the corresponding
genotype.

Table 11 polyT genotype and expected results with the 5T and 9T assays

7T/5T assay result 9T/7T assay result
S 7T (TT) = wc: dye 9T (TT) =V|c: dye
5T (-) =FAM " dye 7T (-) = FAM " dye
9T=unreported 5T=unreported
5T/5T -/- -/-, und, or noampl!
5T/7T TT/- -/-
5T/9T TT/- TT/TT, und?
7T/7T TT/TT -/-
7T/97 TT/TT TT/-
9T/9T TT/TT TT/TT

01 5T/5T samples may be weakly detected by the 7T probe and run at the lower end of the 7T (FAM™ dye)
homozygous cluster (OpenArray™ plates), or may run closer to the NTCs (384-well plates).

(21 5T/9T samples may be weakly detected by the 7T probe and run between the heterozygous and 9T (VIC™ dye)
homozygous cluster.

Data analysis workflow

1. Examine the 5T assay results to identify samples that contain 5T alleles and note
the following:

e 5T homozygous samples run in the -/- (FAM "~ dye homozygous) cluster.
e 5T/7T or 5T/9T heterozygous samples run as heterozygotes.

* Samples that do not contain a 5T allele and that have 7T/7T, 7T/9T, or 9T/9T
genotypes run in the TT/TT (VIC " dye homozygous) cluster.

2. Examine the 9T assay results to determine the 7T and 9T allele component of the
samples:

e 7T homozygous samples run in the -/- (FAM' dye homozygous) cluster.
e 9T homozygous samples run in the TT/TT (VIC ' dye homozygous) cluster.

e 7T/9T heterozygous samples run as heterozygotes.

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide 53



=
=0

;{':.i Chapter 5 Analyze CFTR genotyping data

g Analysis guidelines: SNP genotyping assays to large CFTR mutations

0

>

* For samples that contain the unreported 5T allele:

— 5T/5T samples may be weakly detected by the 7T probe and run at the
lower end of the 7T (FAM ' dye) homozygous cluster (OpenArray
plates), or may run closer to the NTCs (384-well plates).

— 5T/7T samples run in the 7T homozygous cluster.

— 5T/9T samples typically run in the 9T homozygous cluster but may also
run between clusters.

Example data
Figure 8 shows OpenArray  data for 5T and 9T assays.
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Figure 8 PolyT region 5T/7T/9T assay results. Left: 5T (C203006801C_10) assay contains 5T and 7T allele probes; the
7T allele probe also detects the 9T allele, so 5T/7T and 5T/9T samples run as 5T heterozygous. Right: 9T
(C203006801D_20) assay contains 7T and 9T allele probes; 5T/5T samples run near the bottom of the 7T homozygous
cluster. In this experiment, the 5T/9T sample ran between clusters instead of with the 9T homozygous cluster.
[Samples: gDNAs isolated from blood leukocytes]

Analysis guidelines: SNP genotyping assays to large CFTR mutations

CFTRdele2,3 and CFTRdele22,23 are large CFTR mutations that are each interrogated
by a pair of modified TagMan '~ copy number assays. Each assay contains one
functional probe:

e Wild type allele assay — One functional probe (VIC " dye) and one non-functional
probe (FAM " dye)

e Mutant allele assay — One functional probe (FAM " dye) and one non-functional
probe (VIC" dye)

The non-functional probe allows these copy number assays to be run with SNP assay
sets.
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Expected results

e Heterozygous samples amplify with both assays and run in the VIC " dye
homozygous cluster with the wild type assay and in the FAM "~ dye homozygous
cluster with the deletion mutation assay.

* Homozygous wild type samples amplify only with the wild type assay and run
in the VIC™" dye homozygous cluster.

* Homozygous wild type samples do not amplify with the mutation assay, but the
software sometimes assigns genotypes to wild type samples. Change these calls

to noamp.
Wild type assay result Mutation assay result
Genotype ™ ™
VIC " dye FAM " dye
wt/wt wt/wt No amp
mu/wt wt/wt mu/mu

Example data
Figure 9 shows OpenArray = data for CFTRdele2,3 assays.

CFTRdele2,3 mutation CFTRdele2,3 wild type
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Figure 9 CFTRdele2,3 mutant and wild type assay results. Left: CFTRdele2,3 (C990000002A_10) mutation assay;
heterozygous samples run in the FAM™ homozygous cluster; genotype calls were manually changed to "no amp”.
Right: CFTRdele2,3 wild type assay (C990000002B_20); wild type and heterozygous samples run in the VIC™
homozygous cluster. [Samples: Coriell cell line gDNAs]
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Confirm positive results

B Guidelines for confirmation of positiveresults ........................... 56
B Review real-time trace data to confirm positiveresults .................... 57
B Real-time trace dataexamples ........... ... ... ... L 58
B Prepare and run single-tube experiments ............ ... ... ... o ool 60

Guidelines for confirmation of positive results

56

Examine real-time trace data in the allelic discrimination plot to confirm that results
are accurate and are not caused by a rare system error. You can examine real-time
trace data with the QuantStudio 12K Flex Real-Time PCR System software or the
Thermo Fisher Scientific Cloud GT module.
Confirm all ambiguous or homozygous results using any of the following methods:
* Repeat the original experiment.
* Run the sample with single-tube assays on 96- or 384-well plates.

* Run the sample on an additional technology such as capillary electrophoresis
sequence analysis.
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Review real-time trace data to confirm positive results

For assays with positive results, review the real-time trace data to ensure the
genotyping results are valid.

Real-time sample traces for true positive results are:

05
J
L

¢ Linear or curved as appropriate for the sample genotype (samples of the same
genotype should have traces with similar trajectories)

¢ Readily distinguished from the homozygous wild type sample traces

Review real-time trace data:

Software

Procedure

QuantStudio™ 12K
Flex

1.

In analysis settings, select Analyze Real-Time Rn - Median (Rna
to Rnb). This setting will normalize for any run and system

noise to improve data accuracy.

Select Analysis » Allelic Discrimination Plot, then click in

the toolbar.

Plot Type w I8 Change call'y X & W (- N}

3. Select Reveal traces.

Options

0

[ Reveal Taged  Show Oycle: 40

Thermo Fisher
Cloud Cloud

Go to www.thermofisher.com/us/en/home/cloud.html.

Create a project and import one or more OpenArray"
experiment files (.eds).

Open the GT module.
Analyze data.

Real-time trace data is displayed by default in the allelic

discrimination plots.

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide

57


https://www.thermofisher.com/us/en/home/cloud.html

# Chapter 6 Confirm positive results
Real-time trace data examples

Real-time trace data examples

The traces in this section were generated using the QuantStudio 12K Flex software
and are for example purposes only.

Figure 10 is an example of a true positive result that the software can accurately
genotype.

Figure 11 is an example of a result (marked with an x) that the software may
inaccurately genotype.

2143delT

12000

1000 0

000

0o

oo 8000 1300.0 1800.0 23000
Alele 1

Figure 10 Heterogygote (green] and homozygous [red) real-time data traces are clearly
distinguished.
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2184delA

1700.0

1200.0

Allele 2

700.0

000

3000 2000 1300.0 1800.0
Allele 1

Figure 11 Wild type sample real-time data trace trajectory (black] varies significantly
from the trajectories for true heterozygotes (green) and for other homozygous (red)
samples. In addition, nonspecific probe activity can cause homozygous samples (red) to
cluster closer to heterozygous samples at later PCR cycles, but this clustering does not
typically interfere with genotype calls. If necessary, data points from an earlier PCR cycle
can be used to resolve data points that merge together at later cyles (for example, use 40
cycles instead of 50 cycles for analysis).

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide 59



S

geas Chapter 6 Confirm positive results
| O Prepare and run single-tube experiments

At

Prepare and run single-tube experiments

Workflow: single-tube CFTR experiments
“Prepare the DNA sample plate: wet DNA™ on page 61 or
“Prepare the DNA sample plate: dry DNA" on page 61
v
“Perform PCR (single-tube assays)” on page 62
v
Chapter 5, “Analyze CFTR genotyping data”

If you are interrogating mutations that require two assays, review the data
for both assays together.

Required Unless otherwise indicated, all materials are available through thermofisher.com.
materials: single- MLS: Fisher Scientific (www.fisherscientific.com) or other major laboratory supplier.

tube workflow

Item Source

Genomic DNA 5 to 20 ng (diluted in nuclease-free water or 1X TE buffer
as needed)

From Chapter 3, “Isolate DNA using the MagMAX" DNA
Multi-Sample Ultra Kit”

TagMan" Genotyping Master Mix (1 x 1 mL) 4371353
TagMan™ Genotyping Master Mix (1 x 10 mL) 4371355
TagMan" Genotyping Master Mix (1 x 50 mL) 4371357
TagMan" Genotyping Master Mix (2 x 10 mL) 4381656
TagMan" Genotyping Master Mix (2 x 50 mL) 4381657
CFTR assays, 20X Assay Working Stock See “Order single tube TagMan™ assays” on page 17.
(Optional) CFTR TagMan" Assay Controls A30421

MicroAmp" Optical Reaction Plates, any of the following:

MicroAmp" Fast Optical 96-Well Reaction Plate with 4346906
Barcode, 0.1 mL

MicroAmp" Optical 96-Well Reaction Plate with Barcode 4306737
MicroAmp" Optical 384-Well Reaction Plate with Barcode 4309849
UltraPure™ DNase/RNase-Free Distilled Water 10977-015
or

TE, pH 8.0 (1X TE buffer) AM9849
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2

Instruments and software required:

e QuantStudio 12K Flex instrument or thermal cycler

Prepare the DNA
sample plate: wet
DNA 1

Prepare the DNA
sample plate: dry
DNA 1

All wells being tested with a given assay must contain similar amounts of sample
DNA for best results. Include at least 10 samples and 2 NTCs for each assay.

. (Recommended for gDNA) Quantify the DNA (see “DNA concentration and

quantification” on page 31), then dilute in nuclease-free water or 1X TE buffer to
5 to 20 ng per well.

Mix the 2X Master Mix gently. Do not invert the bottle.
Vortex the Assay Working Stock, then centrifuge briefly.
Calculate the number of reactions needed for each assay.

Calculate the volume of each component needed. Include extra reactions to
compensate for the volume loss that occurs during pipetting.

96-Well Fast

Assay

Component 384-Well Plate 96-Well Plate
Plate
TagMan" Genotyping Master Mix 2.50 pL 5.00 uL 12.50 pL
CFTR TagMan" SNP Genotyping 0.25 pL 0.50 pL 1.25 pL

UltraPure™ DNase/RNase-Free
Distilled Water

One of the following:

e UltraPure"” DNase/RNase-
Free Distilled Water (NTCs)

e DNA sample

Varies based on DNA concentration

Total reaction volume

5.00 pL

10.00 pL

25.00 pL

drying time.

All wells being tested with a given assay must contain similar amounts of sample
DNA for best results. Include at least 10 samples and 2 NTCs for each assay.

. Add 5 to 20 ng of DNA to each well. Use 2 to 5 uL sample volumes to minimize

Cover the plate and allow the samples to dry at room temperature in a dark,

amplicon-free location.

If you are using gDNA, do not heat the plate to dry, because it can affect gDNA

recovery.

Mix the 2X Master Mix gently. Do not invert the bottle.

Vortex the Assay Working Stock, then centrifuge briefly.

Calculate the number of reactions needed for each assay.
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6. Calculate the volume of each component needed. Include extra reactions to
compensate for the volume loss that occurs during pipetting.

Component 384-Well Plate | 0" WelLFast | o, well Plate
Plate
TagMan" Genotyping Master Mix 2.50 L 5.00 pL 12.50 pL
CFTR TagMan™ SNP Genotyping 0.25 uL 0.50 uL 1.25 uL
Assay
UltraPure™ DNase/RNase-Free 2.25 uL 4,50 pL 11.25 L
Distilled Water
Total reaction volume 5.00 pL 10.00 pL 25.00 L
Perform PCR Follow the instructions in the instrument user guide for this procedure.
[single-tube 1. Set the following thermal cycling parameters:
assays)
Step Temperature Duration Cycles
Activate 95°C 10 minutes HOLD
Denature 95°C 15 seconds 40
Anneal/ Extend 60°C 1 minute 40

If you are using a real-time PCR instrument, select Standard mode in thermal
cycler settings.

IMPORTANT! Do not use Fast Mode thermal cycling conditions with TagMan"™
Genotyping Master Mix, even when using Fast plates, blocks, or thermal cyclers.

2. Set the following reaction volumes:

MicroAmp" Optical Reaction Plate Reaction volume
384-well 5.00 pL
Fast 96-well 10.00 pL
96-well 25.00 pL

3. Load the plate and start the run.
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RNase P Quantification for
genotyping experiments

Required materials ............ ... ... ... 63
Beforeyoubegin ........ ... 64
Set up and run the PCR, then quantify the DNA .......................... 64

WARNING! Read the Safety Data Sheets (SDSs) and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves. Safety
Data Sheets (SDSs) are available from thermofisher.com/support.

™

In this procedure, the quantification method uses TagMan™ Control Genomic DNA
(human) as a calibrator instead of a standard curve. The OA_Genotyping_CalcSheet
calculates the concentration of test DNA samples with this calibrator method.

Note: The OA_Genotyping_CalcSheet assumes duplicate RNase P reactions in a 384-
well plate layout.

Download the OA_Genotyping_CalcSheet from thermofisher.com/oaqrc.

Required materials

Item Sourcell

TagMan" Copy Number Reference Assay, human, Cat. nos. 4403326 (750 rx),

RNase P (20X) 4403328 (3000 rx)
TaqManTM Control Genomic DNA (human; ready for Cat. no. 4312660
use)

TagMan" Genotyping Master Mix (2X)?! Cat. no. 4371357831

1 thermofisher.com

(2 Any TagMan™ Master Mix can be used, but ensure that the run mode on the instrument is appropriate for the
master mix.

B 50 mL; other sizes available
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Appendix A RNase P Quantification for genotyping experiments
Before you begin

Before you begin

* For best results, dilute test DNA samples 1:10 in Nuclease-Free Water.

* Determine the total number of reactions required. Include:
— Diluted test DNA samples.
— Calibrator DNA sample.

— No-template control (NTC) reactions; use Nuclease-Free Water in place of
DNA sample.

Note: For best results, include a minimum of two reactions for each sample. The
OA_Genotyping_CalcSheet is set up for duplicate reactions.

¢ Generate the RNase P Sample .txt file from the OA_Genotyping_CalcSheet.

Set up and run the PCR, then quantify the DNA

1. Prepare a reaction mix for the required number of reactions plus 10% overage.

Component Volume per reaction!"!
TagMan™ Genotyping Master Mix (2X) 5uL
TagMan™ RNase P Assay (20X) 0.5 L
Nuclease-Free Water 2.5puL
Total 8 uL

1 Refer to the OA_Genotyping_CalcSheet to easily calculate volumes for multiple reactions.

2. Transfer 8 uL of the reaction mix to the wells of a 384-well PCR reaction plate.

3. Add 2 puL of sample DNA, control DNA, or Nuclease-Free Water to the
appropriate wells.

4. Seal the plate with optical film.

5. Set up the real-time instrument with the following settings:
¢ Experiment type: Standard Curve
* Mode: Standard
e Reporter: VIC™
e Quencher: TAMRA™

e Passive reference: included

6. Assign the sample names: import the RNase P Sample .txt file generated from the
OA_Genotyping_CalcSheet.

7. Load the plate and start the run.

8. After the run is complete, deselect all but the Results tab, select a file location,
then export the results.
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Set up and run the PCR, then quantify the DNA

9. Remove duplicate sample IDs from the exported data by opening the exported
data file in Excel™, then:

a. Copy and paste sample names and their corresponding Ct mean values into
a new sheet.

b. Select both columns and use the Remove Duplicates function.
10. Calculate the concentration of test DNA samples: copy and paste the Sample

Names and Mean Cr values into the OA_Genotyping_CalcSheet, and enter the
dilution factor of the test DNA samples into the OA_Genotyping_CalcSheet.
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Safety

A WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

- Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

- Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

- Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

- Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood).

- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.

- Handle chemical wastes in a fume hood.

- Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

- After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

- Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

- IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. All work should be conducted in properly
equipped facilities using the appropriate safety equipment (for example,
physical containment devices). Safety equipment also may include items for
personal protection, such as gloves, coats, gowns, shoe covers, boots,
respirators, face shields, safety glasses, or goggles. Individuals should be
trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow
all applicable local, state/provincial, and/or national regulations. The following
references provide general guidelines when handling biological samples in
laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological
and Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC)
21-1112, Revised December 2009; found at:
www.cdc.gov/biosafety/publications/bmbl5/BMBL.pdf

- World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/cst/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

Document Publication number
CFTR TagMan" Assay Controls Quick Reference MANO0014633
OpenArray” Sample Tracker Software Quick Reference 4460657
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray” 4470935
Experiments User Guide

OpenArray” AccuFill” System User Guide 4456986
TagMan" OpenArray” Genotyping Troubleshooting Guide MANO0011115
TagMan" Genotyper Software Getting Started Guide 4448637

Customer and technical support

Visit thermofisher.com/support for the latest in services and support, including;:
* Worldwide contact telephone numbers
* Product support, including:
— Product FAQs
— Software, patches, and updates
¢ Order and web support
¢ Product documentation, including:
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.

Cystic Fibrosis Transmembrane Conductance Regulator ([CFTR) Genotyping Experiments User Guide 69


http://thermofisher.com/support

Documentation and support
Limited product warranty

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.thermofisher.com/us/en/home/global/
terms-and-conditions.html. If you have any questions, please contact Life
Technologies at www.thermofisher.com/support.
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